Chapter 2

Installing ILWIS 2.2
2.1

The ILWIS 2.2 package and related services

2.1.1

The ILWIS 2.2 package

The ILWIS 2.2 package contains the following items:
§ sealed CD-ROM, containing the system and accessory data;
§ ILWIS Hardware Key (not included when upgrades are involved);
§ ILWIS 2.2 Guide (this manual);
§ Beginner’s Guide;
§ User’s Guide;
§ Applications Guide;
§ Reference Guide.
Upgrades only include the CD-ROM and the ILWIS 2.2 Guide.
If any of these items are missing or damaged, please contact your local distributor or
the PCI-ILWIS Nederland B.V.
Before you break the seal of the CD-ROM, carefully read the terms of the ILWIS
2.2 software license agreement (Appendix G). By breaking the seal you signify that
you have read this agreement and accept its terms.
2.1.2

Warranty

There is a 60-days warranty on the entire package, starting on the date the package
leaves our premises. In the event of notification and return of the defective part(s)
within the warranty period, your local distributor or PCI-ILWIS Nederland B.V. will
replace the defective part(s).
2.1.3

ILWIS hardware key

The ILWIS 2.2 software package is protected against unauthorized use by a unique
hardware key. ILWIS 2.2 software can be executed only when this hardware key is
plugged in properly and you have entered the registration code (see 2.3: Installing
ILWIS 2.2). Do not lose or damage the hardware key, without this key ILWIS 2.2
software can not be activated! Lost or damaged keys will not be replaced. Store the
hardware key in a secure place when not in use. We advise you to insure the ILWIS
hardware key for the price of the package. Furthermore, it is recommended to keep a
copy of your registration code.
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2.1.4

Hardware and software requirements

Technical support and software maintenance

PCI-ILWIS Nederland B.V. provides a Help Desk service to assist users in solving
ILWIS related problems. However, before requiring this assistance, we advise users
to consult the on-line help or documentation. Questions that require in-depth
analysis should be reported through the Customers Services Report Form
(Appendix H).
For up-to-date information concerning ILWIS you can browse to the web address:
http://www.itc.nl/ilwis
The following E-mail addresses are available:
support.ilwis@itc.nl
When you want to know how to achieve a certain
task or when you encounter problems, you can ask
support.
wishes.ilwis@itc.nl
For suggestions and requests for new functionality;
not for support.
bugs.ilwis@itc.nl
To report bugs; not for support.
ilwis@itc.nl
PCI-ILWIS Nederland B.V. E-mail address; for
requests concerning the ILWIS package as a whole,
e.g. pricing, etc.
ILWIS Users may obtain a Software Maintenance Contract (SMC). The SMC covers
all package improvements released by PCI-ILWIS Nederland B.V. during the
contract period. For more information on the SMC, contact your local distributor or
PCI-ILWIS Nederland B.V.

2.2

Hardware and software requirements

2.2.1

Minimum hardware and software requirements

To ensure that ILWIS 2.2 will run under Windows you need at least a CPU with
80386 processor, 8 MB RAM, 256 colors graphics board with a resolution of
640×480, a CD-ROM player and a mouse. The Operating System should be
Microsoft Windows 3.1 or later.
2.2.2

Recommended hardware and software requirements

For best performance of ILWIS 2.2 under Windows, we recommend using a
Pentium class processor (CPU), 16 MB RAM or more and a 24 bit graphics
Windows accelerator board, with a resolution of minimum 1024×768, a CD-ROM
player and a mouse. The recommended Operating System is Microsoft Windows 95
or later.
2.2.3

Digitizers, printers and plotters

The most common method to enter spatial data in ILWIS is by digitizing a map or
any other paper document (e.g. photo-interpretation). To be able to digitize in
ILWIS, a digitizer tablet with a digitizer cursor with a minimum of 4 cursor buttons
is needed. For digitizer installation and configuration, see section 2.4.
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To be able to print or plot maps, graphs and tables, a printer or plotter is needed. For
printer and plotter installation, see section 2.5.
2.2.4

Display drivers

ILWIS makes all graphic calls to Windows. Windows and the associated graphic
display drivers then show the graphic output on the screen. When display problems
are encountered, this may be related to your graphic drivers.
You can check display driver related issues in Win 3.1 by double-clicking the
Windows Setup icon in the Windows Main program group (then under Options,
choose Change System Settings); or in Windows 95, by choosing Start, Settings,
Control Panel (then double-click Display icon and click the Settings tab).
n

n

2.2.5

Make sure that you have installed the correct display driver. If you do not know
which one to use, the option Standard display types should always work. If
you experience any display driver errors, please contact your manufacturer.
To work with ILWIS for Windows you should have a resolution of at least 256
colors (8 bits). Maps are then generally displayed in satisfactorily quality.
When you work with 16 colors only, maps cannot be properly displayed.
Optimal results are achieved when you use display drivers with a pixel depth of
16 or 24 bits (High Color or True Color).

Required hard disk space

For the installation of the ILWIS software, you will need approximately 20 MB of
hard disk space.
For the additional installation of the Beginner’s Guide data, you will need 2.7 MB,
for the User’s Guide data 65 MB, and for the Applications Guide data 100 MB. For
the Georeference Orthophoto exercise you need 17 MB, and for the Geostatistics
exercise 250 KB.
A full installation from CD-ROM thus requires approximately 205 MB.

2.3

Installing ILWIS 2.2
The set up program can be used to:
§ Install ILWIS from diskette or CD-ROM.
§ To add components that were not previously installed.
Before running the ILWIS set up program, it is strongly recommended that you exit
all running programs.
When you have started the set up program, you can step through the different dialog
boxes by clicking the Next and Back buttons. At any time you can to exit the setup
program just by clicking the Cancel button.

2.3.1

Installation from CD-ROM

1.
2.

Place the ILWIS Hardware Key in one of the parallel ports. Printer devices can
still use the selected port simultaneously.
Start up the computer.
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3.

4.
5.
6.
7.
8.

9.

10.

11.

12.
20

Installing ILWIS 2.2
Insert the CD-ROM into the CD-ROM drive and select Run from the Program
Manager File menu (Windows 3.1/NT 3.51) or click the Start button and
select Run… (Windows 95/98/NT4).
Type:
D:\setup.exe (where D is the disk letter of your CD-ROM drive)
The installation starts, and the Welcome dialog box will open.
Read the text in this dialog box and click Next to move to the next dialog box.
Read the text in the Information dialog box and click Next to continue.
The Select Components dialog box opens. Select the components that you
want to install by clicking the check box in front of the components. A
checkmark appears in the check box when a component is selected. To deselect
a component, click a check box again. Some components have sub-components
that can be selected for installation individually. When a component consists of
sub-components, the Change button will become active. Click this button to
view the sub-components and select or deselect them.
When you select a component and mark its check box, all sub-components are
selected automatically. Likewise, removing the mark will deselect all subcomponents. The Change button can then be used to customize the main
setting. Click Next to continue.
The Select Directories dialog box is displayed. The installation offers default
directories in which you can install ILWIS 2.2. Change the defaults or select
other directories by using the Browse buttons to install all components (ILWIS
program files, Beginner’s Guide data, User’s Guide data and Applications
Guide data). Click the Next button.
The Select Program Folder dialog box opens. You can change the default
name proposed to create a new program group (Windows 3.1/NT 3.51) or
program folder (Windows 95/98/NT4). You can also choose to use an already
existing program group or folder. Click the Next button.
ILWIS 2.2 will now be installed. A progress bar appears indicating the status
of installation. Pressing the Cancel button will interrupt the installation
procedure.
During installation ILWIS will try to add ansi.sys in the config.sys file
if not yet included. The setup will search for the ansi.sys file on harddisk,
and if found will ask the user to confirm addition to the config.sys file. A
backup copy of the config.sys file will be made in case you confirm the
addition. The line in config.sys will resemble the line:
device=c:\dos\ansi.sys The ansi.sys driver is used by the
Convert14 program. Although not required, the display of this DOS program
will look much better with the driver loaded.
When the installation is successful the Setup Complete dialog opens. Select
Yes, I want to view the Release Notes and Yes, I want to install the
security key driver and Yes, I want to register the security key. Then click
the Finish button.
Note: Checking the option Yes, I want to register the security key will
automatically select Yes, I want to install the security key driver.
The readme file now opens. Read this file and close it when you are done.
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13. The security key installation will start a separate installation program that will
install the correct driver for the hardware key. It will first ask to select a
language to view the installation in. Then, you are asked to select a directory
for the hardware key utilities. You can choose any directory you like.
14. The Register ILWIS Key program now starts. Carefully enter your
registration code and click OK. The registration code is printed on the inside
front cover of the User’s Guide. Note that The code is case sensitive and must
therefore be entered exactly as written, i.e. with small characters and capitals!
15. When you have installed ILWIS 2.2 correctly and entered your registration
code correctly, you can now run ILWIS 2.2 by double-clicking the ILWIS 2.2
icon in the appropriate folder.
2.3.2

Add components to the current installation

If you did not install all ILWIS 2.2 components during the first installation, this can
be done afterwards.
To add components:
Insert the CD-ROM and select Run from the Program Manager File menu
(Windows 3.1/NT 3.51) or click the Start button and select Run… (Windows
95/98/NT4).
2. Type:
D:\setup.exe (where D is the disk letter of your CD-ROM drive)
3. The Select Components dialog box opens. The set up program automatically
recognizes previously installed components. Select the components that you
want to add and click the Next button to continue.
4. The Select Directories dialog box opens. Modify the default directories to
those into which you want to install the new components. Click the Next
button to continue.
If the setup detects that you deselected previously installed components, it will
display the Confirm Delete Directory dialog. Accept removal of the
previously installed components and install the selected components, or reject
to continue without changing the contents of this directory.
5. The Select Program Folder dialog box opens. In this dialog box select the
desired folder to add the ILWIS 2.2 program icons to, or select another already
existing program folder to which the new program icons must be added. Click
the Next button.
The new components will now be installed. A progress bar appears indicating
the status of installation. Pressing the Cancel button at any time will interrupt
the installation procedure.
6. When the installation is successful, the Setup Complete dialog box opens.
Select Yes, I want to view the Release Notes and click the Finish button to
complete the setup procedure.
7. You can now run ILWIS 2.2 by double-clicking the ILWIS 2.2 icon in the
appropriate folder.
1.
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Uninstalling the ILWIS 2.2 software

To uninstall ILWIS 2.2, double-click the uninstall icon in the ILWIS 2.2 program
folder. All ILWIS 2.2 program files and data that has been added to your hard disk
by the installation program will now be deleted. Data that has not been added by the
installation program (e.g. data that you created) will not be deleted.
When you delete installed files by other methods, a message will appear when using
uninstall afterwards, however this does not effect the uninstall procedure.
Note:
When you created data yourself based on the ILWIS data, make sure that
dependency links of the new data are broken. Otherwise, this data may become
corrupt after the uninstallation.
Before using the uninstall option, copy all installed data files that you do not want to
remove to another directory.
F

2.3.4

Note: To uninstall ILWIS 2.2, you need to use the same Windows version used to
install ILWIS 2.2.

After installation

ILWIS icons

When a full installation is performed, i.e. when all ILWIS 2.2 components are
installed, the new folder ILWIS 2.2 or the selected folder will contain the following
icons:
Double-click this icon to start ILWIS 2.2, with the Beginner’s Guide
data directory as the Start up directory.
Double-click this icon to open the general ILWIS Help.

Double-click this icon to open the ILWIS Help file on operations.

Double-click this icon to open the ILWIS Help file on menu commands.

Double-click this icon to display the release notes.
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Double-click this icon to start the ILWIS Hardware Key registration
program.

Double-click this icon to start the uninstall program.

File structure after installation

The following files are added or changed (assuming all selections were the defaults):
n
An ILWIS 2.2 directory is added to the root;
n
In your Windows directory, an ILWIS.INI file is added;
n
In the SYSTEM.INI file, a HARDLOCK. VXD virtual device driver is added. In
addition, in the [386ENH] section a device= line is added (Windows 3.1
only).
ILWIS 2.2 directory structure

The ILWIS 2.2 directory tree has the following structure:

Where c:\ is the drive and ILWIS22 the directory in which you installed ILWIS
2.2. The files in each chap subdirectory correspond to the files needed for the
chapters in the Applications Guide and the Users Guide.
If you did not perform a full installation, you will only find directories for those
chapters you did install in the above structure.
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2.3.5

Installation and configuration of digitizers

Viewing ILWIS documentation

PDF

files

Most of the printed ILWIS documentation is also available on the CD-ROM in
.pdf format. When you install Adobe Acrobat Reader, you can read all these
files on your screen, exactly as they appear in the printer ILWIS Guides.
The \doc directory on the CD-ROM contains the text files of the ILWIS
documentation, stored in .pdf format, as well as the Adobe Acrobat Reader 3.0.
The Adobe Acrobat Reader 3.0 is used with permission of Adobe Systems
Incorporated. The directory has the following structure:
readpdf

appguide

bgnguide
refguide

usrguide

2.3.6

This directory contains the Adobe Acrobat reader for the .pdf files
and consists of two subdirectories:
16bit: for installing the Adobe Acrobat reader in Windows 3.1
32bit: for installing the Adobe Acrobat reader in all other
Windows platforms.
The 25 chapters of the ILWIS Applications guide, stored as
appch00.pdf (contents and preface), appch01.pdf (chapter 1)
to appch25.pdf (chapter 25).
The file bgnguide.pdf contains the text of the ILWIS Beginner's
guide.
This file contains the 8 chapters and some appendices of the ILWIS
Reference Guide, stored as refch01.pdf (chapter 1) to
refch08.pdf (chapter 8) and refappen.pdf (appendices).
The 13 chapters of the ILWIS User's Guide, stored as
usrch00.pdf (contents and preface), usrch01.pdf (chapter 1)
to usrch13.pdf (chapter 13) and usrindex.pdf (index).

Installing the Adobe Acrobat

PDF

reader

1. Insert the CD-ROM into the CD-ROM drive and select Run from the File menu
of the Program Manager (Windows 3.1/NT 3.51) or click the Start button and
select Run… (Windows 95/98/NT4).
2. Type (for D substitute the disk letter of your CD-ROM drive):
D:\doc\16bit\setup (Windows 3.1)
D:\doc\32bit\setup (Windows 95/98/NT3.51/NT4)
3. Follow the instructions of the set up program.
The set up program will create a program group Adobe Acrobat on your hard disk,
and it will associate .pdf files with the Adobe Acrobat Reader. After that you can
open the .pdf files and look at their contents. There is no need to copy the .pdf
files to the hard disk: they can be viewed from the CD-ROM. You can also print and
copy the files or parts from it.

2.4

Installation and configuration of digitizers
The most common method to enter spatial data in ILWIS 2.2 is by digitizing a map
or any other paper document (e.g. photo-interpretation). To use a digitizer, it must
be properly installed and configured first. Depending on the type of digitizer used,
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the digitizer can be configured manually or with the use of a WinTab driver. The
digitizer manufacturer usually supplies a WinTab driver. It is advised to use a
WinTab driver, because it makes it easier to set up your digitizer and the digitizer can
be used for other applications too.
2.4.1

Set up your digitizer using a WinTab driver

1.
2.
3.
4.
5.
6.
F

2.4.2

Connect all cables of the digitizer to the proper components.
Install the WinTab driver (see your digitizer manual or WinTab
documentation).
Start ILWIS 2.2.
In the Main window, open the Options menu, choose Digitizer, Setup
Digitizer. The Setup Digitizer dialog box appears.
Select the WinTab option to configure your digitizer.
You can now reference your map (see How to reference a map in the Reference
Guide) and start digitizing (see How to digitize in Reference Guide).

When you start Windows after you have installed the WinTab driver and the
digitizer is disconnected or switched off, an error message is displayed because
Windows can not detect the tablet. If you continue, the digitizer cannot be used,
unless you connect and/or switch on the tablet and reboot your system.

Set up your digitizer manually

1. Connect all cables of the digitizer to the proper components.
2. Configure your digitizer, using the configuration software and/or the digitizer dip
switches. Make sure that the digitizer:
n
is set in stream (run) mode (sometimes called continuous mode),
n
sends data in ASCII format,
n
gives Carriage Return (cr) and/or Line Feed (lf),
n
sends data using serial communication (rs-232-c),
n
supports Xon/Xoff signals.
3. Write down the configuration for the Baud Rate, Parity, Data Bits and Stop Bits
and the Resolution (lines per inch or per mm). For more information, refer to
your digitizer manual or section 2.4.3, where the settings for some widely
available digitizers are described.
4. Up until this stage, you do not need ILWIS yet!
5. Start ILWIS 2.2.
6. In the Main window, open the Options menu, choose Digitizer, Setup Digitizer.
The Setup Digitizer dialog appears.
7. Select the serial port (COM1 to COM4) to which your digitizer is connected. A
message box now appears which lists the communication settings of the selected
port (baud rate, parity, data bits, stop bits, flow control).
8. Make sure that these port settings are exactly the same as the communication
settings of your digitizer you wrote down at step 3. If these settings are exactly
the same press yes to open the Setup digitizer dialog box and continue with
step 9. When the settings do not match press No to open the Control Panel
(Windows 3.1) or the System Properties (Windows 95), and change the Port
settings until they match the digitizer configuration. Go back to step 5.
ILWIS 2.2 Guide
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9. When communication is established between the digitizer and the port, the
coordinates are displayed as readable numbers that change when the digitizer
cursor is moved. Continue with step 10. If this is not the case, check the set up of
the digitizer tablet itself, and change the port settings accordingly to the digitizer
settings until you have communication. When you do have communication, but
not in readable numbers, it is most likely that you did not configure the digitizer
in ASCII mode or the wrong port settings are selected. If so, reconfigure the
digitizer in ASCII mode or change the port settings.
10. Follow the instructions for automatic set up; press the digitizer cursor buttons
which you want to use as buttons 0, 1, 2 and 3 (Press the button you want to use
as 0 button, when asked Press Button 0, etc.). Remember the sequence you
have entered, because these are the buttons you have to press to execute the
command following a 0, 1, 2 or 3 in the different Digitizer Menus of the editors.

Figure 1: Setup digitizer size dialog

11. In the upper part of the Setup Digitizer Size dialog (see Figure 1): check if all
buttons work, and check whether the X-values increase by moving the digitizer
cursor to the right, and Y-values increase by moving the cursor up. If the
communication is not correct, press Cancel to return to the previous dialog box
and change until the communication is correct. When you have good
communication, fill out the resolution (lines per inch or per mm) that the
digitizer is using and the size of the digitizer. Remember to enter the same
resolution, as you have configured for your digitizer (in step 3). You can check
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the resolution by locating the digitizer cursor in the upper right corner of the
tablet. The received X and Y coordinates (in mm or inch) mentioned under the
Lines per mm (or inch) option should now be equal to the filled out digitizer
size (at the bottom of the dialog). If the resolution is not correctly specified, an
incorrect scale will be displayed during Map Referencing. Check the feedback
you obtain in the lower part of the dialog and make changes until satisfied.
12. Reference your map (see How to reference a map in the Reference Guide) and
start digitizing (see How to digitize in the Reference Guide).
Troubleshooting

If for some reason the automatic set up does not work, it is also possible to do the set
up manually. Click the manual button in the Setup Digitizer dialog. You can now
enter the format and the flag codes in the dialog. These can be obtained by analyzing
the received coordinates in the second dialog. These contain the amount of
characters, the position and amount of the X and Y characters and the flag codes.
Move the cursor horizontally and vertically over the tablet to obtain X and Y
position. The flag codes can be obtained by pressing the cursor buttons sequentially.
The corresponding characters will show on the flag codes position.
Received Coordinates:
03791,07676,0
Means:
Format:
Flag Codes:

XXXX,YYYY,c (Format: X, Y, flag codes)
1248 (depending on the tablet you use)

And thus:
Nr chars:
X Pos:
X Length:
Y Pos:
Y Length:
Flag Pos:
Flag Codes:

the amount of characters in the format is 11
the start position of the first X character is 1
the amount of X characters of the format is 4
the start position of the first Y character is 6
the amount of Y characters of the format is 4
the position of the flag codes is 11
the flag codes are 1248

Note that all characters are counted as positions. You can also find the format and
flag codes in your digitizer manual. You can now enter the format and flag codes in
the dialog and click OK to continue with step 11.
2.4.3

Settings for some widely available digitizers

The next pages list possible configurations of some well known digitizers. Note that
these are just suggestions; digitizers can often be configured for several data formats.
This appendix only presents one of the possibilities; other configurations may well be
possible. Note that the set up is not always automatically saved, this depends on the
type of digitizer used. In some cases, it may well be possible that you have to
reconfigure your digitizer every time you use ILWIS! Read your digitizer manual for
more information.
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If your digitizer does not store the setup, put the setup command in the autoexec.bat.

CalComp 2000

Dip switch settings:
1
2
3
4
5
6
7
8
9
S1 open open close open close close open open open
S2 open close open open close close open open close
S3 open open open open open open open open close
This configures the digitizer for the following set up:
Baud Rate 9600, Even Parity, 7 Data Bits, 1 Stop Bit and Resolution 1000 lines per
inch.
Format: XXXX,YYYY,c
Flag Codes: 1248
CalComp Drawing Board 2

All sizes, using the set up menu.
Menu settings:
1

bank A
bank B

2

3

4

5

6

7

8

9 10 11 12 13 14 15 16 17 18

1 1 0 0 0 0 1 0 1 1
0 0 1 0 0 1 0 0 0 0

0
0

0
0

0
0

0
0

0
0

0
0

1
0

0
0

This configures the digitizer for the following set up:
Baud Rate 9600, Even Parity, 7 Data Bits, 2 Stop Bits and Resolution 1000 lines per
inch.
Format: XXXXX,YYYYY,c
Flag Codes: 1248
CalComp Drawing Board 3

All sizes, using the set up menu.
Menu settings:
1

bank A
bank B
bank C

2

3

4

5

6

7

8

9 10 11 12 13 14 15 16 17 18

1 1 0 0 0 1 0 0 1 1
0 0 1 0 0 1 0 0 0 0
0 0 0 0 0 0 0 0 0 0

0
0
0

0
0
0

0
0
0

0
0
0

0
0
0

0
0
0

1
0
0

0
0
0

This configures the digitizer for the following set up:
Baud Rate 9600, Even Parity, 7 Data Bits, 2 Stop Bits and Resolution 1000 lines per
inch.
Format:
XXXXX,YYYYY,c
Flag Codes: 1248
N u m o n i c s 2 2 0 5 ( 1 2 ” × 12”) / 2206 (12” × 1 7 ” )

Dip switch settings:
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1
off

2
off

3
off

4
on

5
on

6
on
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7
off

8
on

This configures the digitizer for the following set up:
Baud Rate 9600, Even Parity, 7 Data Bits, 2 Stop Bits and Resolution 200 lines per
inch.
Format:
XXXX,YYYY,c
Flag Codes: 1234
Numonics 2207

The program SETTAB.COM, which is a content of your digitizer package, is
needed to configure your digitizer.
To configure:
Go in DOS to the directory where SETTAB.COM is located.
Type:
SETTAB ASCII 7E COM1
(enter)
The digitizer is now configured. This will set your digitizer on ASCII format, with 7
data bits and even parity on comport 1. Make sure that the tablet is attached to the
specified Comport (here: COM 1). If the tablet is attached to another Comport,
change the 1 in the formula in the Comport no. used (e.g. 2).
Then RESTART Windows (NOT your computer!) and start ILWIS.
This configures the digitizer for the following set up:
Comport 1, Baud Rate 9600, Even Parity, 7 Data Bits, 2 Stop Bits and Resolution 200
lines per inch.
Format: XXXX,YYYY,c
Flag Codes: 1248
Numonics GraphicMaster

To configure the digitizer for ILWIS:
This digitizer can be configured with Softkey Selection (See the digitizer manual).
First align the Numonics set up Sheet with the bottom left side of the digitizer. Then
remove the digitizer cursor. Install the cursor again, but when you do this, keep one
cursor button pressed down. The set up Menu is now active. Select Baud Rate 9600,
8 Data Bits, None Parity, 1 Stop Bit, Enable XON/XOFF, Stream Mode, Stream
Rate 20, Metric Resolution 10 (not higher, or the format changes) and Standard
Formats S-BP1 ASCII.
Exit with Save Configuration.
This configures the digitizer for the following set up:
Baud Rate 9600, None Parity, 8 Data Bits, 1 Stop Bit and Metric Resolution 10 lines
per mm.
Format: XXXX,YYYY,c
Flag Codes: 1248
Numonics GraphicMaster II

To configure the digitizer for ILWIS:
This digitizer can be configured with Softkey Selection (See the digitizer manual).
ILWIS 2.2 Guide
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First align the Numonics set up Sheet with the bottom left side of the digitizer. Then
place the cursor over the Softkey labelled set up. The beeper will emit a continuous
series of beeps. Press and hold any cursor button, until the beeper stops. The set up
Menu is now active. Select Standard Formats S-BPII ASCII, Baud Rate 9600, 7
Data Bits, Even Parity, 2 Stop Bit, Enable XON/XOFF, Stream Mode, Stream Rate
20, Metric Resolution 10 (not higher, or the format changes).
Exit with Confirm Change or Save to.
This configures the digitizer for the following set up:
Baud Rate 9600, Even Parity, 7 Data Bits, 2 Stop Bits and Resolution 200 lines per
inch.
Format: XXXX,YYYY,c
Flag Codes: 1248
SummaSketch II

The SummaSketch does not have the possibility to store a configuration. The programs
SEND.COM and MMRST.COM, which are a content of your digitizer package, are
needed to configure your digitizer.
To configure:
Go in DOS to the directory where SEND.COM and MMRST.COM are located.
Type:
mmrst /1
send /1 /Cza@
(enter)
The digitizer is now configured. Make sure that the tablet is attached to the specified
Comport (here: COM 1). If the tablet is attached to another Comport, change the 1
in the formula in the Comport no. used (e.g. 2).
This configures the digitizer for the following set up:
Comport 1, Baud Rate 9600, Odd Parity, 8 Data Bits, 1 Stop Bit and Resolution 20
lines per mm.
Format: XXXX,YYYY,c

30

ILWIS 2.2 Guide

Printer and plotter setup

2.5

Installing ILWIS 2.2

Printer and plotter setup
In ILWIS a printer and/or plotter is necessary to generate output of maps and
images. This chapter describes the steps to set up a printer or a plotter. Note that
using a plotter under Windows may cause problems, we therefore recommend to
create a plot file instead and send this to the plotter.
We will only describe the setup procedure for a printer, because the setup procedure
for printer and plotter is identical. Simply read plotter instead of printer for a plotter
setup.
Set up your printer:
1. Connect all cables of the printer to the proper components. Make sure that you
connect a parallel printer to a parallel port and a serial printer to a serial port!
2. Install the printer driver (see your printer manual or Windows documentation).
3. Configure your printer using the printer configuration software (and/or dip
switches). For more information about the configuration, see your printer
manual.
4. Start ILWIS.
5. Open the Printer Setup dialog box: open the File menu of a graph window,
table window or a map window, and select the option Printer Setup. Fill out the
following options:
–
Default printer: Select this option when the printer that you want to use is set
as the default, or
–
Specific printer: Select the printer you want to use; ILWIS simply lists
installed printer drivers.
–
Orientation: Select the orientation of the paper in relation to the map(s) you
want to print:
–
Portrait: Vertical paper orientation.
–
Landscape: Horizontal paper orientation.
–
Paper: Select the paper size and the source of the paper:
–
Paper size: Select the paper size for the selected printer, e.g. A4 or A3, or
another paper size appearing in the drop-down list box. The paper sizes that
appear depend on the printer driver.
–
Source: Select the paper source for the selected printer. The paper sources
that appear in the drop-down list box depend on the printer driver.
–
Options button: Controls printer settings for the printer you select in the
Specific Printers list. The available options vary depending on the printer
driver. To get Help for the selected printer, choose the Options button, and
then choose the Help button.
–
Network button: Connects your computer to a network printer. The Network
button is available only if your computer is connected to a network. To get
Help on network printers, choose the Network button, and then choose the
Help button.
6. Click the ok button to finish the set up, or the cancel button to return without
changes.
7. You can now print, see the Reference Guide : How to print maps, tables and
annotation
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